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[bookmark: _Toc213942131]ABSTRACT
The NDSU disquisition templates are designed for your convenience, but they will require additional formatting to fit the style manual of your discipline. Furthermore, we recommend reading the accompanying manual for these templates, located on our website: www.ndsu.edu/cfwriters/disquisitions/guidelines-templates-forms.
This page is required as page “iii” of the disquisition. Use the “NDSU Paragraph Double Space 0.5 First Line” style for the paragraph text. Abstracts for doctoral dissertations must use 350 words or less. Abstracts for master’s papers or master’s theses must use 150 words or less. Note: This abstract will be used in your publication entry in the online repository.
[bookmark: _Toc213942132]ACKNOWLEDGMENTS
Acknowledgments text should be placed here. In this section you can acknowledge or thank those who assisted or supported you in your disquisition, and you can acknowledge any external funders that may have supported your project with grant funding. Use the “NDSU Paragraph Double Space 0.5 First Line” style for the paragraph text. This page is optional—delete if not using.
[bookmark: _Toc213942133]DEDICATION
This section dedicates the disquisition to one or more persons, groups, or causes as tribute to their support or influence. The text must be double spaced and aligned center to the page with no paragraph indentation. This page is optional—delete this page if you are not using it.
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[bookmark: _Toc213942134]LIST OF TABLES
Table	Page
1.	Title of table in “NDSU Table Title” style, which uses the same font typeface and font size as the paragraph text, single spaced. Table titles using this style are automatically placed into the List of Tables. Right-click the list and update it to pull the title into the list. After updating a prefatory list, remove the “table” and “figure” label from in front of each number and apply the “Prefatory List” style to the entries. You may need to fix the alignment of the entries after updating. If you use bold for the table and figure numbers in the chapters, as this template does, remove the bolding in the List of Tables/Figures when you update the entries.	2
2.	Title of table in “NDSU Table Title” Style from the Styles pane.	5

[bookmark: _Hlk201922169]NOTE TO USER: To populate the List of Tables with titles and to update with changes, right click on the entries, choose “Update Field” then choose to update the page numbers only or update the entire table if you made changes to or added new table titles. When you update the whole table you will have to reformat the list to manually remove the label word “Table” from each entry, and realign the entries. Use the style “List of Tables/Figures/Etc Entry” to help with formatting and Tab settings to align entries. DELETE THIS NOTE BEFORE YOU SUBMIT YOUR DISQUISITION.
[bookmark: _Toc213942135]LIST OF FIGURES
Figure	Page
1. 	Title of figure in “NDSU Figure Title” style. This style automatically places 24 pts of line spacing after figure titles; if you include a figure note, you will need to manually adjust this line spacing, as there should be no more than one line of space (12 pts) between a figure title and a figure note. This spacing is demonstrated here.	3
2. 	Title of the figure. This style automatically places 24 pts of line spacing after figure titles; if you include a figure note, you will need to manually adjust this line spacing, as there should be no more than one line of space (12 pts) between a figure title and a figure note. This spacing is demonstrated in figure 1 (above).	6

NOTE TO USER: To populate the List of Figures with titles and to update with changes, right click on the entries, choose “Update Field” then choose to update the page numbers only or update the entire table if you made changes to or added new table titles. When you update the whole table you will have to reformat the list to manually remove the label word “Figure” from each entry, and align the title column. Use the style “List of Tables/Figures/Etc Entry” to help with the formatting and Tab settings to align entries.  DELETE THIS NOTE BEFORE YOU SUBMIT YOUR DISQUISITION.
[bookmark: _Toc213942136]LIST OF _______
Item 	Page
1. 	Title of example is formatted in “NDSU Other Item Title”. You can use this style to make the list of items that you need and update the entries in the extra “LIST OF ____” after the LIST OF FIGURES in the prefatory section.	4

NOTE TO USER: If you have non-text items other than tables or figures in your disquisition, you may need to label them and list them in a prefatory directory like this one. Examples include musical examples, schematics, code examples, algorithms, equations… You can relabel the title and column header of this page to suit your needs and populate it with the item titles formatted with the style “NDSU Other Item title”. DELETE THIS NOTE BEFORE YOU SUBMIT YOUR DISQUISITION.
[bookmark: _Toc213942137]LIST OF ABBREVIATIONS
Abbreviation	Explanation of the Abbreviation. Remove these entries before submitting your disquisition.
[bookmark: _Hlk201922296]Directions	This page has been formatted with an automatic dot leader and our required alignment. Press “Enter” after the previous definition to start a new entry. After typing the abbreviation, press “Tab” once to get the Dot Leader up to the definition column. There is also a Style for these list entries: “List Entry Abbreviations, Symbols”. Remove these entries before submitting your disquisition.
ETD	Electronic Thesis or Dissertation
[bookmark: _Toc213942138]LIST OF SYMBOLS
[bookmark: _Hlk201920707]Symbol	Explanation of Symbol. If the symbol text runs longer than one line, the subsequent lines are aligned with the first word in the entry. Remove this entry before submitting your disquisition.
Directions	After entering the Symbol, press Tab to get an automatic dot leader to the definition column. After typing the definition, press Enter to start a new line for a new symbol. Remove this entry before submitting your disquisition.
™	Trademark
[bookmark: _Toc213942139]LIST OF APPENDIX TABLES
Table	Page
A1.	Title of appendix table in “NDSU Appendix Table Title” style from the Styles pane. Appendix tables should include the letter of the appendix in its number (if you have only one appendix, then use the default letter “A” in the number).	8

[bookmark: _Toc213942140]LIST OF APPENDIX FIGURES
Figure	Page
A1.	Bison art created in a beta version of Adobe Firefly, a generative AI app. Title of appendix figure in “NDSU Appendix Figure Title” style.	8
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[bookmark: _Toc213942141][bookmark: _Hlk201922362]MAJOR HEADING FOR FIRST CHAPTER USING STYLE “NDSU 0 MAJOR HEADING/CHAPTER TITLE”[footnoteRef:2] [2:  If co-authored materials are included in your disquisition, a clear and complete description of your contribution must be included. No co-authored materials can be included in the disquisition if your contribution is modest, even though you may have been included as a co-author. The mandatory description of your role must be placed in a footnote, indicated at the chapter heading in which the co-authored material appears. You can find an example of this footnote on our website.] 

[bookmark: _Hlk201922387]Use our “NDSU” styles to simplify your formatting. The styles in these templates have been provided for your convenience, and it is your responsibility to use them appropriately to create a document that complies with the NDSU Format Guidelines. If you would prefer to use different styling, such as a different font or to change the line spacing before and after non-text items, you are welcome to change the styles in any way that conforms to the Format Guidelines. 
If you are pasting in text from another source, you should strip the formatting from it before copying into your disquisition. We recommend using Paste Special – Unformatted Text (hotkey Ctrl+Alt+V) to remove other formatting that may be on that text before applying the appropriate style from the Styles Pane. 
Styles for headings, paragraph text, non-text items, and many other elements are available in this template, but you may need to modify them to fit the style manual of your discipline. For paragraph text, use the style “NDSU Paragraph Double Space 0.5 First Line”. 
For bulleted list items, use the “NDSU Bullets” style from the styles pane. Bulleted and numbered lists should be formatted consistently throughout the document.
[bookmark: _Hlk211431288][bookmark: _Hlk201929464]Aside from creating a consistently formatted document, styles are used to auto-populate and update the Table of Contents and Lists of Tables/Figures/etc. For headings, use the styles marked NDSU 0-4. Styles for non-text items are marked as “table”, “figure”, etc. You should make modifications to the styles when necessary—refer to our user guide (“How to Use NDSU Disquisition Templates” on our Disquisition Formatting Guidelines web page) and our Formatting Tutorial videos on the GPS Academy YouTube channel for more information about formatting with styles, modifying styles to fit your style manual’s guidance, and using and adjusting this template.
[bookmark: _Hlk201922598]Note that you not be able to automatically populate and update the Table of Contents and prefatory lists if styles are not used appropriately for their respective items. 
[bookmark: _Toc213942142]First Level Subheading Using Style “NDSU 1”
[bookmark: _Hlk201922610]An example table is below. Your tables and table titles can look different from the example; we encourage you to follow the style of your discipline. A consistent design is required for all of your tables, including the use of borders, font, and the line spacing before and after your tables (including titles and notes). Non-text items, like tables, should not extend into the 1” page margins; enables gridlines in the View tab to better see items that extend into the page margins. The line spacing options used in the template styles have been set for their most common use, and are not intended to work for all situations—you will need to review the line spacing options for non-text items on a case-by-case basis.
[bookmark: _Toc205814287][bookmark: _Hlk201926686][bookmark: _Hlk201926830]Table 1. Title of table in “NDSU Table Title” style, which uses the same font typeface and font size as the paragraph text, single spaced. Table titles using this style are automatically placed into the List of Tables. Right-click the list and update it to pull the title into the list. After updating a prefatory list, remove the “table” and “figure” label from in front of each number and apply the “Prefatory List” style to the entries. You may need to fix the alignment of the entries after updating. If you use bold for the table and figure numbers in the chapters, as this template does, remove the bolding in the List of Tables/Figures when you update the entries.
	Column 1
	Column 2
	Column 3
	Column 4

	Row 1
	“Table text” style
	Data
	Data

	Row 2
	Data
	Data
	Data


[bookmark: _Hlk201926783]Note: The “NDSU Table Note” style is used to format table notes, including line spacing. Table notes are single spaced and have the same font typeface and font size as the paragraph text. If you do not have a table note, you will likely need to change the line spacing manually after the table. See our website or the text at the bottom of page 9 in the appendix for more information. 
[bookmark: _Toc213942143]Second Level Subheading in Style “NDSU 2”
[bookmark: _Hlk201922756]All non-text items should conform to a consistent line spacing scheme. More information, including examples and settings on line spacing for non-text items, can be found on our website.
[bookmark: _Hlk201927103]Third Level Subheading in Style NDSU 3
[bookmark: _Hlk201922859]A sample figure is shown below. Set images to be in-line with text and use the appropriate style to format them, such as the “NDSU Figure” style. All images in your document will require alt-text. Figures and other non-text items should be formatted according to your discipline’s style guide—it may differ from our examples.
[image: A photograph of Bison Statue #1. The bison statue sits in front of South Engineering, across from the Library and Minard Hall. It was donated to NDSU by Jim and Sandra Roers, with contributions from Ronald G. and Kaye S. Olson and Student Government. It is dedicated to the memory of Dr. Les Pavek, Vice President of Student Affairs, and Michael William Barner. The statue once stood inside of a bank in Minnesota.]
[bookmark: _Toc213942418][bookmark: _Hlk201923017]Figure 1. Title of figure in “NDSU Figure Title” style. This style automatically places 24 pts of line spacing after figure titles; if you include a figure note, you will need to manually adjust this line spacing, as there should be no more than one line of space (12 pts) between title and note.
Note: Use NDSU Figure Note for any notes related to a figure. If you reproduce content from published material, you must cite the original source of the item and obtain any necessary permissions to reproduce it. Refer to the style manual of your discipline and our Format Guidelines for more information about copyright.
Non-text item titles and notes should be on the same page as table or figure itself. For example, if a table or figure can fit on the same page as its title and notes, all of that table or figure—including its title and notes—should appear on one page, regardless of whether it creates a large gap in your content. If an item is too large to fit onto a single page, see our website for more information on how to create multi-page tables and figures.
Fourth-level Subheading in Style “NDSU 4”
Below is a musical example. Things like schematics, musical examples, and other non-text items should be labeled and titled and included in an appropriate prefatory list. 
[image: An excerpt of a duet written for a flute and clarinet in 6/8 time. The flute plays a lively melody with eighth- and sixteenth notes while the clarinet plays a slower, sustained accompaniment using quarter notes and longer tones. ]
[bookmark: _Toc148027178]Musical Example 1. This title is formatted in “NDSU Other Item Title”. You can use this style to make the list of items that you need and update the entries in the extra “LIST OF ____” after the LIST OF FIGURES in the prefatory section.
Note: Use the “NDSU Other Item Note” style for notes on these types of items. If you have multiple types of “other items”, you may need to create styles for each type.
Fourth-level Subheading in Style “NDSU 4”
We recommend hosting your code on a public repository and linking to it from your disquisition. If you include code in your document, use the “NDSU Listing/Code” styles. See Appendix C and our website for more information about listings.
Listing 1. Use “NDSU Listing/Code” style to format code blocks. If you wish to maintain indentation from pasted code, you may have to manually use CTRL+TAB to indent items.
function [k,dk] = getk(t2,Emin,Emax,bpm,ts,te)
	t1 = t2 - ts;
	a=1; %scales normal distribution to 1
	b=.5*60/bpm; % centers the mean at 1/2 of the cycle
	c=.13*b;% .23=50% duty cycle, .13= 1/3 duty cycle
	k=(Emax-Emin)*a*exp(-(t1-b).^2 /(2*c.^2))+Emin;
	dk=(Emax-Emin)*a*exp(-(t1-b).^2 /(2*c.^2)).*(-2*(t1-	b)/(2*c.^2)) + (Emax-	Emin)*a*exp(-(t1-b).^2 /(2*c.^2)).*(-	2*(t1-b)/(2*c.^2));
End
Note: Notes for listings/code blocks should use the “NDSU Listing/Code Note” style and should employ the same line spacing scheme before and after them as other non-text items. Like other non-text items, a listing shouldn’t be broken across pages if it can fit onto a single page.
[bookmark: _Toc213942144]MAJOR HEADING USING STYLE “NDSU 0: MAJOR HEADING/CHAPTER TITLE”[footnoteRef:3] [3:  If your chapter is using or reproducing content that is now or will be published, and that content has co-authors listed in the publication, then you must include a footnote to the chapter title with the appropriate acknowledgments, including any instructions from the publisher to cite the publication. These acknowledgements are mandatory and must follow the Graduate School’s guidelines for describing your role in the co-authorship. Details and an example are on our General Requirements web page under “Copyright”. To insert a footnote, go to the References tab in the Word ribbon and click “Insert Footnote”—do not place it in the footer.] 

[bookmark: _Toc147744725][bookmark: _Hlk201924277]You should review your document before and after it has been printed to PDF to ensure its compliance with the Format Guidelines. You can view formatting marks using the “Show/hide formatting marks” button on the Home tab in the Paragraph section (Ctrl+Shift+8). Some formatting is embedded in styles for your convenience; for example, the major heading style automatically forces the heading to appear at the top of a new page. We do not recommend using line breaks (Enter) to space out content, as any changes to line spacing or other formatting above the line breaks will likely cause issues for content below the line breaks. Instead, if you need to force content onto a new page—such as a full page table or figure—insert a page break on the Insert tab. Warning: Use page breaks, not section breaks, unless you are inserting landscape pages.
[bookmark: _Toc213942145]First Level Subheading in Style “NDSU 1”
[bookmark: _Toc147744727]Paragraph text paragraph text paragraph text paragraph text paragraph text paragraph text paragraph text paragraph text.
[bookmark: _Toc148017014][bookmark: _Toc205814288]Table 2. Title of table in “NDSU Table Title” Style from the Styles pane.
	Column 1
	Column 2
	Column 3
	Column 4

	Row 1
	
	
	

	Row 2
	
	
	


Note: This style (NDSU Table Note) is used for any table notes.
[bookmark: _Hlk201924462]If you use equations in your text, they should be centered to help them stand out from the paragraph text. If you number the equations, they must either be numbered consecutively throughout the document (1, 2, 3, etc.) or consecutively within each chapter (1.1, 1.2, 2.1, 2.2, etc.), and the equation numbers must be flush against the right margin. Use the “NDSU Equation” style to automatically set the tab stops, but you must tab the equation and number manually. This style sets two tab stops: a 3.25” centered tab is used for the equation and a 6.49” right tab is used for its number.
		(1)
		(2)
[bookmark: _Toc147744729]More information on tab settings for equations can be found in our “How to Use NDSU Disquisition Templates” on our Disquisition Formatting Guidelines web page and the Format Guidelines wiki page for equations.
[image: A Bison logo from NDSU Athletics.]
[bookmark: _Toc213942419][bookmark: _Hlk201924769]Figure 2. Title of the figure. This style automatically places 24 pts of line spacing after figure titles; if you include a figure note, you will need to manually adjust this line spacing, as there should be no more than one line of space (12 pts) between a figure title and a figure note. This spacing is demonstrated in figure 1 (above).
[bookmark: _Toc213942146]REFERENCES
[bookmark: _Hlk201924858]Citation example using the “NDSU Citation” style. This style is double spaced with a hanging indent, but you are welcome to use a format that fits your disciplinary conventions. 
[bookmark: _Hlk201924843]Follow your discipline’s style guide for reference list formatting guidance and modify our style as needed. 
[bookmark: _Hlk201924850]Use only one citation style. For example, do not mix APA and AMA citation styles in your document.
[bookmark: _Hlk201924805]Before submitting your document, proofread all entries. Citations that have been automatically generated by citation management software likely have missing information or inconsistent formatting. Double-check all citations for accuracy and completeness, paying special attention to capitalization, punctuation, author names, font style, consistency in how you list journal titles (e.g., full vs. abbreviated, italicized), and compliance with the citation style manual you are using.
Citation citation citation citation citation citation citation citation citation citation citation citation citation citation.
[bookmark: _Toc213942147]APPENDIX A. FORMATTING IN THE APPENDIX 
[bookmark: _Toc147744732][bookmark: _Hlk201924905]If you include appendices in your document, review the Format Guidelines for appendices thoroughly, as they contain specific instructions pertaining to how your appendix material should be presented. For example, if you have only one appendix, then remove the letter A from the major heading, but keep using the letter A in any table and figure numbers to denote that they are appendix tables and figures.
[bookmark: _Toc148016770][bookmark: _Toc201927547][bookmark: _Toc205814485]Table A1. Title of appendix table in “NDSU Appendix Table Title” style from the Styles pane. Appendix tables should include the letter of the appendix in its number (if you have only one appendix, then use the default letter “A” in the number).
	Column 1
	Column 2
	Column 3
	Column 4

	Row 1
	“Table text” style
	
	

	Row 2
	
	
	


Note: This style (NDSU Table note) is used for any table notes.
[image: AI slop of a bison.]
[bookmark: _Toc148016202][bookmark: _Toc205814543]Figure A1. Bison art created in a beta version of Adobe Firefly, a generative AI app. Title of appendix figure in “NDSU Appendix Figure Title” style.
[bookmark: _Hlk211431514]Note: This style (NDSU Figure Note) is used for any figure notes, regardless of whether they appear in the chapters or appendices. Remember that the value of academic accountability must guide the use of AI tools, and you must cite any AI-generated work.
[bookmark: _Toc213942148]APPENDIX B. RESOURCES AND MORE INFORMATION FOR DISQUISITION WRITERS
	NDSU Website
	For more information about:

	Graduate School Current Students
	Graduate School policy, deadlines, forms, graduation.

	· https://www.ndsu.edu/graduate-school/academic-support

	Graduate School Dissertations, Theses, and Papers
	Disquisition policies, formatting guidelines, templates, a guide to using the templates, submission procedures, publication and delayed release information.

	· https://www.ndsu.edu/cfwriters/disquisitions

	Center for Writers
	Writing consultations, writing workshops, disquisition boot camps, writing resources on site and online.

	· www.ndsu.edu/cfwriters/

	Instructional Design Center (IDC)
	Thesis formatting workshops. Help with our template. Help with using Microsoft Word and other software applications. Walk-in consulting service in Quentin Burdick Building 150C, or schedule an in-person or virtual appointment with their thesis formatting specialist. Note: The IDC offers technical help with Word but does not consult on guidelines nor conduct reviews of your formatting.

	· https://www.ndsu.edu/it/help/idc

	Formatting Tutorial Videos
	Hosted on the GPS Academy YouTube Channel. “Navigating the Review Process” workshop recording and “Word Crash Course” videos on In-Paragraph Formatting; Styles; Section Breaks and Page Numbers; Table of Contents; Tables and Figures; Landscape Pages and More about Tables; Template Overview.

	· https://youtube.com/playlist?list=PLWKsN3lW50IexOpLRkNjh2HDuVKp3XjFH&si=Cksb4ZlFK3X1uCCh


Note: Non-text items like tables or figures that appear alone in an appendix do not require titles and should not have entries in a List of Appendix Tables/Figures. See our website for more information.

[bookmark: _Toc213942149]APPENDIX C. FORMATTING CODE IN THE CHAPTERS AND APPENDICES 
We recommend hosting your code on a public repository, such as GitHub, and linking to the repository from your disquisition. If you need to include snippets, pseudocode, scripts, or  code in general within your disquisition, you can use the “NDSU Listing/Code” style to format code blocks with line numbers and border frames; use the accompanying “NDSU Listing/Code” styles for titles and any notes. Formatting requirements and troubleshooting for listings can be found on our website. If you have listings within your disquisition, we recommend including a List of Listings in the prefatory pages. See the Required Order of Elements on our website for information on this list’s placement.
Listing C1. Code should be formatted using “NDSU Listing/Code” style. This style applies a number to each line. If necessary, you can use CTRL+TAB to indent items on a line.
1: function [k,dk] = getk(t2,Emin,Emax,bpm,ts,te)
2: t1 = t2 - ts;
3: a=1; %scales normal distribution to 1
4: b=.5*60/bpm; % centers the mean at 1/2 of the cycle
5: c=.13*b;% .23=50% duty cycle, .13= 1/3 duty cycle
6: 
7: %makes the spread of curve to 50% duty cycle
8: k=(Emax-Emin)*a*exp(-(t1-b).^2 /(2*c.^2))+Emin;
9: dk=(Emax-Emin)*a*exp(-(t1-b).^2 /(2*c.^2)).*(-2*(t1-b)/(2*c.^2)) + (Emax-	Emin)*a*exp(-(t1-b).^2 /(2*c.^2)).*(-2*(t1-b)/(2*c.^2));
10: End
11: 
12: function [k,dk] = getk(t2,Emin,Emax,bpm,ts,te)
13: 
14: t1 = t2 - ts;
15: a=1; %scales normal distribution to 1
16: b=.5*60/bpm; % centers the mean at 1/2 of the cycle
17: c=.13*b;% .23=50% duty cycle, .13= 1/3 duty cycle
18: 
19: %makes the spread of curve to 50% duty cycle
20: k=(Emax-Emin)*a*exp(-(t1-b).^2 /(2*c.^2))+Emin;
21: dk=(Emax-Emin)*a*exp(-(t1-b).^2 /(2*c.^2)).*(-2*(t1-b)/(2*c.^2)) + (Emax-Emin)*a*exp(-(t1-b).^2 /(2*c.^2)).*(-2*(t1-b)/(2*c.^2));
22: End
23: 
24: function [k,dk] = getk(t2,Emin,Emax,bpm,ts,te)
25: 
26: t1 = t2 - ts;
27: a=1; %scales normal distribution to 1
28: b=.5*60/bpm; % centers the mean at 1/2 of the cycle
29: c=.13*b;% .23=50% duty cycle, .13= 1/3 duty cycle
30: 
31: %makes the spread of curve to 50% duty cycle
32: k=(Emax-Emin)*a*exp(-(t1-b).^2 /(2*c.^2))+Emin;
33: dk=(Emax-Emin)*a*exp(-(t1-b).^2 /(2*c.^2)).*(-2*(t1-b)/(2*c.^2)) + (Emax-Emin)*a*exp(-(t1-b).^2 /(2*c.^2)).*(-2*(t1-b)/(2*c.^2));
34: End
35: 
36: function [k,dk] = getk(t2,Emin,Emax,bpm,ts,te)
37: t1 = t2 - ts;
Notes for listings/code blocks should use the “NDSU Listing/Code Note” style and should employ the same line spacing scheme before and after them as other non-text items. Like other non-text items, a listing shouldn’t be broken across pages if it can fit onto a single page.
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